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Product Warranty Statement

LINK ENGINE MANAGEMENT LTD — LIMITED LIFETIME WARRANTY

All Engine Control Units (ECUs) manufactured or distributed by Link Engine Management Ltd are
subject to the following LIMITED LIFETIME WARRANTIES, and no others.

Link Engine Management Ltd warrants only to the original purchaser of the ECU, for the lifetime of
the ECU, (subject to the limitations set out below), that the ECU shall be free from defects of
materials and workmanship in the manufacturing process. This warranty ceases to apply and does
not apply to ECUs that have not been manufactured or distributed by Link Engine Management Ltd
for a period of greater than one year.

An ECU claimed to be defective must be returned to the place of purchase. Link Engine Management
Ltd, at its sole option, may replace the defective ECU with a comparable new ECU or repair the
defective ECU.

This limited lifetime warranty is not transferable and does not apply to any ECU not properly installed
or properly used by the purchaser or end user, or to any ECU damaged or impaired by external
forces. The above warranties are the full extent of the warranties available on the ECU. Link Engine
Management Ltd has no liability to the original purchaser or any other person for any loss, injury or
damage to persons or property resulting from the use of the ECU or any failure of or defect in the
ECU whether by general, special, direct, indirect, incidental, consequential, exemplary, punitive, or
any other damages of any kind or nature whatsoever. Link Engine Management Ltd specifically
disclaims and disavows all other warranties, express or implied, including, without limitation, all
warranties of fitness for a particular purpose, warranties of description, warranties of merchantability,
trade usage or warranties of trade usage.

For off-road use only, not intended for highway vehicles. This ECU contains a user-configurable
software programme, which is updated by Link Engine Management Ltd from time to time. The user
must ensure the current correct version of this programme is downloaded from the website of Link
Engine Management Ltd and installed in the ECU prior to use. This limited lifetime warranty does not
apply where the ECU has been installed with the incorrect version of the software programme. The
user is solely responsible for the setup and testing of all user-configurable features.

Link Engine Management Ltd License Agreement

The software programme in this ECU is licensed not sold. Link Engine Management Ltd grants the
user a license for the programme only in the country where the programme was acquired. No other
rights are granted under this license and the programme may only be used on one machine at a
time. If the programme is transferred a copy of this license and all other documentation must be
transferred at the same time. The license may be terminated by the user at any time. Link Engine
Management Ltd may terminate the licence if the user fails to comply with the terms and conditions
of this license. In either event the copy of the programme must be destroyed.






Contents 5

Table of Contents

Part | G4X and G5 Plug-In ECU Installation Manual 6
T 1o o 11 T (e o 6
T =1 e T 6
DT o7 =TT 1= 6
ST oY« o] o Q0 01§ o 3 = 6
2 Pre-Installation............coooiiiiiimeeii s s rs s s s r s s nnan s n e 6
Board SWitCh Settings .....ccciiiiriir i 7
74 O SO 7
[ Yoo o1, Lo Yo Lo 11T 4 RS 7
74 O SO 7
R T T = 11 = 1o o 7
ECU HaNAIING PrOoCEAUIES ....cccciocieciiiiieirsinssnstsessessessmssmssmssms s s ssmssmssssnssssssnsssssssassnssnssnssssssmssmssmssmsssessnnsnssnssnsnsanes 7
4T gV =T = O R 8
MR2Link V1, MR2Link V2-3, JZX90, JZX100 and SUPraLinK...........cceereerierireneeisieieeieseeicsee e 8
4 Additional Sensors/Functions
N o= 1T
Jzxeo ...
IAT Sensor  .......
JZX90 e
E-Throttle Output
JZX90 e
L= (o X=Ta L7 [0 1 070 T 1 7= o1 {1
B PO TUNING. .. s
INSTAIlING USB DIIVOI'S ..uciisuisismssssassnssssnssnsassnssnsassssssssssssassnssssasssssssmsssssssnssssssssssssssssssssssssnsssssssnssssssnnssssnsnnssssassnssssn 10
Installing PCLiNk TUNING SOftWAre ......c.ccuummmmsmismsmssmismsmsnissssssssmsssssssmssssssssssssssssssssssssssssssssssssssssasssssssnssssassnsssss 10
Communicating With YOUE BCU ........ccccuimmmsmsmimmmssnsssmsssssssssssssssssssssssssssssssssssssasssssssasssssssnssssassnssnsassnsansmssnsassnsss 10
6 Pre-Start Configuration...........cccccciciriririsisirrscssr s s ss s s 1"
FITMW ArE VEISION .oieicciiceiecise e sccss s cessst s seseess e ss s s s e snesssmnss st a s e smesssmnea st s s ansne e smnanssasansnesnsmnanssnsansnssnsmnsnssnsnnsnsen 1
L= 2o I 0o 1) o 11 11 o o 11
[V PN RS T=Y 0 0] 0= 11T 0T -4 o o 11
307 11 o 1T o R 12
1 RS T=T 4 E-T oY ST (=Y o1 4o o S 12
10 oY TR =4 o B T o TN ==Y {1 o L 12
JLILET T L= 0 1T T - 11 oo 12
7 First Time Startup......cccooee oot r e s s e e s e s e s s e s e mnmas s s e s e e s e mnmamss s s e e e e nnmnmnnsn 13
L 1 1T UL 15
74, (< 0T 15
L= T OV 18 111 (] 3 .1 F- 1o o 17
74, (< 0 17
10 KNOWN ISSUS...cecemueeeiicirirrnnmnmssssssssrsnrmnmassssssse s nrmnmsmss s s sn s s e nsmnmss s asnsnsnsmnmsmsssssnsnsnnmnmnnsnsnnnsn 17
7.4, (. 0 TSR 17

© 2023 Link Engine Management Ltd



Link ECU Online Manual

1
1.1

1.1.1

1.1.2

11.3

1.2

G4X and G5 Plug-in ECU Installation Manual
Introduction

Thank you for purchasing your Link Plug-In Engine Control Unit (ECU), an advanced, fully programmable

microprocessor controlled Engine Management System.

G4X software employ high resolution fuel and ignition tables with configurable load and RPM centres. When

coupled with up to six dimensional fuel and ignition mapping, barometric pressure compensation and intake

air temperature correction this gives an unprecedented level of tuning accuracy. All Link G4X ECUs are in-field
upgradeable, there is no need to return the unit for software updates.

All Link G4X Plug-In Engine Management Systems are designed with flexibility and ease of installation in

mind. Link Plug-In systems are designed to replace the circuit board inside the factory ECU enclosure. This

provides an invisible install that requires minimal modification to vehicle wiring and ECU mounting.

Installing and tuning any after market engine management system is not to be taken lightly. G4X ECUs give

the tuner the control & flexibility that only top after-market engine management systems in the world can

provide. While every effort has been made to keep G4X ECUs as user friendly as possible, it should be
recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two important tasks:

1. This manual covers the installation of your G4X ECU. While it is not strictly essential that this work is
performed by an automotive electrician, the knowledge and tools available to these professionals makes it
highly recommended. Regardless of who does the installation, it is of utmost importance that instructions
provided in this manual are followed exactly throughout the installation.

2. Once the G4XECU has been installed it will need to be tuned using a laptop computer with PCLink
software. Information on the configuration and tuning of the G4X ECU is detailed in the help section of
PCLink. G4X ECUs are shipped pre-loaded with a base configuration that should be close enough to get
most engines running after a few application specific adjustments have been made. While hearing the
engine running on the new ECU for the first time is always a satisfying feeling, it is important to realise
that the job is not complete. The amount of tuning performed and the experience of the tuner are the two
most important factors in determining how happy you will be with your engine management system.

Safety Notice

Your Link Plug-In ECU is designed to enhance the performance of your vehicle. Howewer in all cases, your
vehicle must be operated in a safe manner. Do not tune your vehicle while operating it on public roads.
WARNING!
Failure to follow all installation and operating instructions may result in damage to
the Link ECU, personal injury, or harm to property.

Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the vehicles wiring harness
are correct. However due to variations between vehicle models it is the installers responsibility to check wiring
connections BEFORE installing the ECU. Link will not be held responsible for any damage caused by the
incorrect installation of this product.

Support Options

Should any issues arise during installation, the following options exist for technical support:

1. PCLink help, press F1 while running PCLink

2. Contact your nearest Link dealer. A Link dealer list is available on our website.

3. Link website: www.linkecu.com with Online Discussion Forum.

4. Technical Support Email: tech@linkecu.com

The majority of questions received by the technical support team are clearly answered in the manuals. Please
consult the manuals to make sure that your question has not already been answered.

Pre-Installation

Before installing the Link G4X ECU into the vehicle some pre-installation checks must be performed.

© 2023 Link Engine Management Ltd
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1.2.1 Board Switch Settings

Some Link G4Xrequire switches on the board to be set before installation.
1.21.1  JZX90

The G4X JZX90 plug-in ECU has a jumper to select where the MAP signal is coming from. The ECU contains
an internal 7Bar (3Bar of boost) MAP sensor and this jumper connects either this sensor to An Volt 1 or
connects the signal from the factory MAP sensor to An Volt 1. A diagram is provided on the PCB to indicate
how the jumper should be installed for each setup.

1.2.2 Loom Modifications
1.2.21 JZX90

The JZX90 Plug-in ECU is capable of Sequential Injection, To use Sequential Injection follow the steps below:

1. Run new wires from the expansion plug with Injector drives 4, 5 & 6 through to the engine bay. The Link
expansion loom or a custom loom can be used for this.

2. Wire each injector drive to the injector on it's corresponding cylinder, cylinder 1 and injector drive at the
front of the engine, cylinder 6 and injector drive 6 at the rear of the engine (gearbox end). which injector
drive is which can be found by looking at wire colours at the ECU header plug or by using the injector test
settings.

3. Set Injection Mode to sequential and store.

4. Test your wiring by running the injector test on each injector and ensuring the correct injector and only
that injector operates when it is being tested. It is best to do this without having the fuel system primed to
prevent flooding but preferably not completely dry to prevent injector wear.

1.3 Installation
This guide provides information on correctly and safely installing your new Link G4X Plug-In ECU.

1.3.1 ECU Handling Procedures

WARNING!!!
The following installation process will require handling of both the Link ECU and
factory ECU. Both of these are highly sensitive to electrostatic discharge and are
easily damaged. Follow the anti-static precautions given in this manual carefully
to awoid damaging electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

© 2023 Link Engine Management Ltd
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1.3.2

1.3.21

ANTI-STATIC HANDLING GUIDELINES

A
ALad

Your body builds up an electrical charge as you mowe around. This charge can reach very high
wltages. Whenever given the opportunity this energy will attempt to discharge (usually through
your finger tips!). This can be fatal to most electronic components. Most people have
experienced an electrostatic discharge when they step out of their car or touch a metal bench
top.

The following guidelines describe precautions that can be taken to reduce the possibility of
damaging your ECU:

1. Work only on a conductive surface. A clean steel bench is suitable.

Always wear a wrist strap that is electrically connected to the conductive

working surface. An Anti-static wrist strap is included for use during install

Touch the working surface regularly.

Do NOT touch components on the circuit board.

Where possible, only handle the ECU by its plastic header.

Do NOT carry the ECU around without anti-static packaging.

. Do NOT touch the bare terminals in the ECU header.

Obsening the above procedures will minimise the chance of damaging the ECU. Note that
failure due to static damage often does not appear until well after it was caused.

N

No o ko

Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

MR2Link V1, MR2Link V2-3, JZ2X90, JZX100 and SupraLink

The following steps outline the installation procedure:

1.

Removwe the factory ECU from the vehicle: Ensure the key is in the OFF position. The factory ECU is
located:

e Celica, JZ2X90 and JZX100 - in the center of the vehicle under the dash

o MR2 - in the boot attached to the firewall

e Supra - under the passenger foot panel

Unplug the wiring harness from the factory ECU. Remowe the bolts that retain the ECU mounting
structure and remowve the ECU from the vehicle. DO NOT touch the exposed pins in the factory ECU
connector.

Removwe the factory ECUs circuit board from its enclosure: Ensure you are following the given anti-static
guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP connected to a conductive working
surface. Remowe the top cover by removing the side retaining screws. Remowe the circuit board by
removing the corner screws. Hold it only by the plastic header and place it aside.

Modify the case if required: It may be necessary to cut the center bar out of the enclosure using the
appropriate tool. This will be necessary if the center bar interferes with the ECU.

Connect the ECU USB tuning cable and the expansion loom to the Link Plug-In ECU if required.

Fit the Link Plug-In ECU: Place the Link ECU on the base plate and carefully fit the four corner screws.
Place the factory ECU in the packaging your Link ECU came in for its protection.

Refit the top cower: It may be necessary to widen the slot around the main header to allow cables to exit.
Ensure that any modifications are de-burred to prevent cutting into cable insulation.

Reassemble the enclosure and fit the ECU back to the vehicle.

Connect the ECU to the factory wiring loom.

Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of this manual first.

© 2023 Link Engine Management Ltd
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Note: The bolt that holds the Toyota Supra header plug in place will screw right through all the thread and
spin. This is normal.

1.4 Additional Sensors/Functions

G4X Plug-In ECUs offer various options for the installation of additional sensors and devices. As a minimum it
is recommended that all ECUs are installed with a Manifold Absolute Pressure (MAP) sensor and Intake Air
Temperature (IAT) sensor. These parts can be purchased if required from your nearest Link dealer.

141 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure source after the
throttle body. It is common to 'T into the fuel pressure regulators pressure signal. Do NOT share this signal
with other devices such as boost gauges or blow off valves.

Note: Internal MAP Sensors on new plug-in ECUs have changed from 4Bar to 7Bar. The 7Bar versions should
be identifiable by a sticker on the bottom board and can also be confirmed by comparing MAP and BAP when
the MAP vacuum line isn't connected to see if they match with the calibration being used.

1.4.1.1 JZX90

The G4X JZX90 Plug-In ECU supports several options for fitting of a MAP sensor. Any one of the following

options can be used:

1. Factory MAP Sensor — The JZX90 has a MAP sensor from factory, this sensor is connected to An Volt 1
via a jumper so either the factory or the internal Map sensor is connected to An Volt 1.

2. Internal MAP Sensor — To ease installation the G4X JZX90 ECU is fitted with an internal MAP sensor. This
sensor is either rated to 4.0 Bar absolute pressure (3.0 bar boost) or 7.0 Bar absolute pressure (6.0 bar
boost) depending on the age of the bottom board. Which sensor is fitted can be ascertained by looking at
the sticker on the bottom board (should say 7 Bar for 7 Bar models and nothing for 4 Bar) or by looking at
the MAP value when at atmospheric pressure and changing the calibration setting. The internal MAP
sensor is wired to An Volt 1 via a jumper so either the internal or the factory Map sensor is connected to
An Volt 1.

3. MAP Via Expansion Connector - The expansion connectors provide power, ground, and analog channels
for the connection of a MAP sensor.

Make sure that the correct MAP sensor input has been selected in PCLink and a MAP calibration has been
performed before attempting to start the vehicle.

142 |AT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for correction of
fuel and ignition based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location that accurately represents intake
temperature. The most common location is just prior to the throttle body. Installing in the manifold is not
recommended due to heat soak issues. A fast response sensor must be used in all forced induction
applications.

1.4.21 JZX90

From factory, models supported by the G4X JZX90 Plug-In ECU are fitted with an IAT sensor. The G4X JZX90
Plug-In ECU supports several options for fitting of an IAT sensor. Any one of the following options can be
used:

1. Factory IAT — An Temp 2 is wired to the factory IAT sensor.

2. |AT Through Expansion Connector - The expansion connector provides ground and temperature channels
for the connection of an IAT sensor. Wire the sensor between the Ground pin and an An Temp channel
pin. Note spare An Volt channels can be used as temperature inputs when a pullup resistor (to +5V) is
added.

© 2023 Link Engine Management Ltd
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1.4.3 E-Throttle Output
1.4.3.1 JZX90

This ECU has a dedicated E-Throttle Expansion Connector which contains Aux 9 & Aux 10 and four An Volt
inputs. Aux 16 is setup to control the E-throttle power and so needs to be set as the E-Throttle Relay.

144 Expansion Connector

Expansion connectors are provided to allow easy connection of additional ECU inputs. An “expansion cable”

can be purchased from your Link dealer.

Important points when wiring to the expansion connector:

¢ Do not owverload the +5V Out pin. Although this is protected against ECU damage the +5V out signal also
provides power for other sensors.

¢ Do not connect the ground pin to chassis ground. This could cause ground loops and introduce
unnecessary interference. Use this pin only to ground external sensors that are isolated from chassis
ground.

The Expansion connectors available for each ECU can be found under the Pinouts Section.

1.5 PC Tuning

1.5.1

1.5.2

153

G4X ECUs require PC/laptop tuning using the PCLink Tuning Software application running on a Windows
based computer. PCLink may be downloaded from www.linkecu.com. Note that when new versions of PCLink
are released they are posted on the website and may be downloaded at no cost. Also note that G4X ECUs
must be used with the correct version of PCLink.
IMPORTANT!
The G4X ECU has on board USB.

BEFORE connecting the ECU to your laptop, the USB drivers must be installed.

Failure to install the drivers on your laptop first may result in windows assigning

incorrect drivers. These drivers will not work with the G4X ECU and are difficult to

uninstall. The correct USB drivers are installed as part of PCLink installation, as

described in the following section. Should internet download not be practical, a

copy of the drivers on CD can be obtained from your nearest Link dealer.

Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. These drivers are
installed as part of PCLink installation as described in the following section.

Installing PCLink Tuning Software

Due to the frequent updates PCLink is no longer shipped with each ECU. You will be required to download the

latest version of PCLink from: linkecu.com

Should access to an Internet connection be impractical, download the latest version of PCLink elsewhere to a

USB drive, and then install on your laptop.

Installing from the web

1. Go to the above website and navigate to the downloads and software updates section.

2. Download the latest version of PCLink. When prompted to run or save the file, select sawe. It is
recommended to sawe this file on the desktop.

3. Double click the saved file and follow on screen instructions.

4. When prompted to install USB drivers, select yes. This may take some time.

5. When installed, open PCLink by double clicking on the icon that has been placed on the desktop.

Communicating With Your ECU

After PCLink installation, you will be able to connect the G4X ECU to the laptop to perform set-up and tuning
work.

© 2023 Link Engine Management Ltd
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1. Connect the ECU to your laptop using a Link G4X ECU USB Cable. If not supplied with the ECU, these
can be purchased from a Link dealer. No other adapter or cabling is required. Connect the cable to the
connector labelled USB.

2. Ifthis is the first time you have connected a G4X ECU USB cable to your laptop follow the driver

installation instructions that appear. When prompted if you want to install drivers select 'Continue

Anyway'.

Start PCLink by double clicking on the PCLink icon on the windows desktop.

Switch the key to the ON position. This will provide power to the ECU.

5. In PCLink, under the 'Options' menu, select 'Connection'. The connection options dialogue will open.
Select the correct COM Port number from the drop down list or select auto for automatic com port
detection.

6. PCLink offers both mouse and keyboard control. To establish a connection between the PC and ECU
press the F3 key. The same process can be used to disconnect. If a successful connection is
established, PCLink will download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of PCLink.

8. To permanently STORE any changes made to the ECU press F4. If this is not done before turning the
ECUs power off all changes made will be lost.

Bl

1.6 Pre-Start Configuration
Before starting the vehicle, important pre-start configurations need to be made.
1.6.1 Firmware Version

It is recommended to ensure that the Link G4X ECU is running the most up to date firmware. Firmware
version information can be obtained by connecting to the ECU with PCLink and selecting 'ECU Information'
under the Help menu.

The latest firmware can be downloaded from our website with PCLink.

It is recommended that this is performed by an experienced Link dealer as new features may need to be
properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu in PCLink, follow
the on screen instructions to complete the firmware update process.

1.6.2 Base Configuration

All G4X Plug-In ECUs are shipped with base configuration settings. Note that these are provided to reduce
initial setup and tuning times. They are NOT recommended tuning values. PCLink includes base
configurations for various models. Download the appropriate base configuration into your ECU with PCLink by
connecting to the ECU (described in the Connecting To PCLink section of this manual), then selecting 'Open'’
under the 'File' menu. Select the appropriate .pclx file and then select 'Open'. Downloading large configuration
files can take up to a few minutes. Be patient and acknowledge any messages PCLink shows.

1.6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should always match the

Barometric Absolute Pressure (BAP) Sensor. As well as providing altitude correction, the BAP sensor also

allows the MAP sensor to be calibrated prior to tuning.

Link G4X ECUs use an on-board barometric sensor that is calibrated prior to dispatch. This ensures that all

PCLink tune files (pclx Files for G4X or pcl5 for G5) give a consistent state of tune throughout the ECU range.

This allows a tune file to be transferred between G4X based ECUs giving an equivalent state of tune providing

all factors affecting volumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there would be

significant affects on the accuracy of the resulting tune, especially when tuning with Manifold Gauge Pressure

(MGP) as a load index.

To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the MAP sensor.
Select the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.

© 2023 Link Engine Management Ltd



12 Link ECU Online Manual

Follow the on screen instructions.

Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).
Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).
Perform a 'Store' by pressing F4.

No ok~

A more in depth explanation is provided in the PCLink help Manual under PCLink G5 Users Manual -> Tuning
Operating Procedures -> ECU Controls -> MAP Sensor Calibration.

164 TPS Calibration

Non E-Throttle Vehicles:

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine management parameters
used by functions such as idle speed control,acceleration enrichment and motor sport features. It is important
that the ECU knows when the throttle is open and closed (or part way in between). The following procedure
calibrates the ECU to match the TPS and is for engines using a cable driven throttle:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

2. Open Analog Inputs ->Throttle Position Sensor and ensure that the TPS (Main) Source is set to the
correct input. Refer to the Pinouts section of this manual for details.

Under the 'Options' menu, select TPS calibration'.

Follow the on screen instructions.

Select the 'General' tab in the runtime values section of PCLink (lower part of the screen).

Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when fully open.
Perform a 'Store' by pressing F4.

No ok~

1.6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and fitted to the intake
system. It is important that the ECU is calibrated to match the sensor installed in the engine. This procedure
is as simple as selecting the correct sensor type as follows:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using PCLink.

Click on 'Analog Channel' in the configuration tree.

Select the An Temp channel the sensor has been wired to.

Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.

Select the correct Temp Sensor Type'.

Select the 'Analog Inputs' tab in the runtime values section of PCLink (lower part of the screen).

Ensure that IAT reads the correct temperature.

8. Perform a 'Store' by pressing F4.

1.6.6 Inputand Output Setup

As the Link G4X Plug-In ECUs are often designed to run several models there are a few items that must be
set-up to make the ECU specific to your model.

The Pinouts section of this manual gives a list of the functions of each channel based on the target vehicle.
It is the tuners responsibility to make sure that the following channels are set-up correctly for the vehicle
model the ECU is fitted to:

All Auxiliary Output Channels

Use the Test On' or Test PWM' (at 10 Hz) functions to test the wiring of channels.

All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

All Analog Volt and Temperature Inputs

Look at the Analog Inputs runtime values (lower section of the PCLink screen) to confirm each channels
operation.

Nookwd

1.6.7 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous sections have been
completed. Only after all pre-start checks have been made should an attempt be made to crank the engine.
The following steps must be performed before an attempt is made to start the engine to ensure the G4AX ECU
is calibrated to precisely measure engine position.

© 2023 Link Engine Management Ltd
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—_

. Connect the ECU to PCLink.
2. Select 'Fuel', then 'Fuel Set-up"
a. Set ‘Injection Mode’ to OFF. This will prevent the engine from trying to start while the triggers are
calibrated.
b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is lost.
3. Click on ‘Triggers’ then ‘Calibrate Triggers’.
4. Perform the correct trigger calibration procedure specific to your vehicle as described in the PCLink help
(Press F1).
Note that trigger calibration must be performed again once the engine is running. Due to the acceleration and
deceleration of the crankshaft at low speeds, an inaccurate measurement of engine timing is usually made.
Also it is often harder to see timing marks with a timing light at slow engine speeds. Trigger calibration should
be checked again at between 2000-4000 RPM where engine speed is stable and a more consistent timing
reading can be obtained.

A more in depth explanation is provided in the PCLink help Manual under G4X ECU Tuning Functions ->
Triggers -> Calibration.

1.7 First Time Startup

For further help on any of the settings discussed below, consult the Help in PCLink Tuning Software. Help
can be invoked by pressing F1, or right clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks

Before attempting to configure the ECU, ensure the following tasks have been completed:

1. Ensure the ECU and all associated components are connected and correctly wired/installed.

2. Fully charge the wehicle’s battery, as the engine will be required to be cranked during the set-up
procedure.

3. Check all oil and water lewels are correct.

Connecting to PCLink Tuning Software

Use the following procedure to establish a connection between your Link ECU and PCLink Tuning Software

tuning software.

1. Make sure your laptop battery is fully charged or plugged in to mains power.

2. Connect the ECU to your laptop and connect to PCLink as described in the '‘Communicating with your
ECU' section of this manual.

First Time Startup

After performing all set-up instructions given in previous sections, including trigger calibration, the engine is

now ready to be started. The following procedure should be used for first time start-up.

1. Turn the ignition key OFF then ON. The fuel pump should prime momentarily upon power up.

2. Connect the ECU to PCLink.

3. Access the runtimes values by pressing the F12 Key, click the 'Analog' tab:

a. TPS — spans from 0 to 100% when throttle is pressed. If not, perform a TPS Calibration. If the vehicle
has an E-Throttle confirm that APS (Sub), APS (Main), TPS (Sub), TPS (Main) all operate correctly
and that the throttle blade tracks the target correctly.

b. MAP — should read approx 101 kPa (at sea level) with the engine not running. If not, check the MAP
Sensor Type setting and perform a MAP Calibration.

c. ECT - should read current engine temperature.

d. IAT — should read current intake air temperature.

e. Digital Inputs (click the 'Digital' tab) — Operate switches connected to any digital inputs while watching
the runtime value to ensure they operate as expected.

Rectify any faults found in Step 3.

5. Ensure the basic Fuelling setup is correct.

a. If using Traditional Fuel Equation Mode then locate the 'Master Fuel' setting in the ECU Settings Menu
under: Fuel > Fuel Setup > Fuel Main. This will need to be adjusted during or just after start-up.

b. If using one of the Modelled Fuel Equation Modes then navigate to Fuel > Fuel Setup > Fuel main and
enter the correct engine capacity, correct base fuel pressure, and correct fuel properties. Navigate to
>Fuel>Fuel Setup>Injector Setup, enter correct injector flow rate and rated pressure.

&
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6. Crank the engine until it starts. Some throttle may be required for first time start-up due to imperfect
tuning.

a. If using Traditional Fuel Equation Mode the Master Fuel settingcan be used to enrich/lean the engine
(increase to enrich).

b. If using one of the Modelled Fuel Equation Modes the Injector Flow Rate can be decreased to add
more fuel, this will need to be changed back to the correct value later but works well for first start
purposes.

7. If the engine fails to start after several attempts, do not crank it endlessly. Stop and determine the
problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers runtime values tab). If this value increases
during cranking/running then there is a trigger setup fault. It is not unusual for this number to count one or
two on the first engine revolution.

9. Once the engine starts:

a. If using Traditional Fuel Equation Mode adjust the Master Fuel setting to achieve best possible running

b. If using one of the Modelled Fuel Equation Modes adjust the Injector Flow Rate setting to achieve best
possible running, this will need to be changed back to the correct value later but works well for first
start purposes.

10. The engine should now be allowed to fully warm up. It may be necessary to readjust ‘Master’ several
times to maintain smooth running. Don'’t forget to keep an eye on engine temperature.

11. Once the engine is warmed up and running well, perform another trigger calibration (known “as setting the
base timing”).

12. Perform a Store by pressing F4.

Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have been completed
and the engine is running. The following steps detail correct set-up procedures for some of the more critical
ECU parameters (note that MAP Sensor Calibration should have already been completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually opening. Likewise,
there is a small delay between the injector being de-energised and the injector closing. The opening time is
considerably longer than the closing time, however the overall result is that less fuel will flow for a given pulse
width than would be expected with an ‘'ideal injector'. To compensate for this the injector pulse widths are
increased to compensate for this 'dead-time’. The dead-time for a given injector is a function of the battery
woltage, differential fuel pressure and the type of injector driver (saturated or peak and hold). A typical dead-
time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond = 1 thousandth of a
second).

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the differential fuel
pressure (difference between manifold pressure and fuel pressure) will be constant. Therefore the only variable
that is changing will be the battery woltage (this changes with electrical load and sometimes engine speed).
Without correction, the changes in dead-time will cause the engine to run lean when the voltage drops. If the
Injector Voltage Correction is properly set-up then changes in the battery woltage will not affect the air/fuel
ratio.

The injector dead-time table allows the dead-time for different battery wltages to be entered. The values
represent the dead-time in milliseconds. These should increase with falling system woltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or on a running
engine.

To determine the injector dead-time using a flow bench, the injectors need to be operated at the intended
operating pressure (normally three bar) and at a constant duty cycle as well as a set wltage. Vary the supply
woltage to the injector and measure minimum pulse width at which the injectors will flow for a particular
wltage. This is the required dead-time for that injector at that tested woltage.

To determine injector dead-time on a running engine, with the engine fully warmed and operating at stable
air/fuel ratios (a very precise AFR meter is required — a narrow band O2 sensor will not suffice), electrical
drain needs to be applied to the system; the preferred method is disconnecting the alternator main fuse.
Battery load testers are also useful here too.

Watching the air fuel ratios change while the battery woltage drops, the dead-time table can be trimmed to
maintain the same stable air/fuel ratio. Injector dead-time can be viewed as a row graph. A smooth curve
needs to be maintained at all times.
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NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector dead-times.

Traditional Fuel Equation Mode Master Fuel Setting

If using Traditional Fuel Equattion mode the Master Fuel setting should be set so that the numbers in the
middle of the fuel table end up around a value of 50. This is to allow sufficient span of the numbers in the main
fuel table.

1.8 Pinouts
Pin information is provided to assist when troubleshooting. All pinouts are looking into the ECU (wire side).

1.8.1 JZX90

35 36 37 38 39 40 57 58 59 60 73747357677 787980

41 42 43 |44 45 g > 673 31 82 83 84 85
L ] U a

35 90 91 92 93

Pin ECU Pin Function Pin ECU Pin Function
1 Injector 1 Injection 65 nc
2 Injector 2 Injection 66 nc
3 Injector 3 Injection 67 nc
4 Aux 1 Purge 68 Ground
5 nc 69 nc
6 Knock 1 Knock 70 nc
7 Knock 2 Knock 71 nc
8 Injector 7 (Aux) NB O2 Heater 72 nc
9 nc 73 nc
10 nc 74 nc
11 Ignition 2 Ignition 75 nc
12 Ignition 3 Ignition 76 Ignition 7 AC Clutch
13 nc 77 nc
14 DI 1 Start Switch 78 nc
15 nc 79 nc
16 nc 80 nc
17 Ignition 4 Ignition 81 nc
18 nc 82 DI 3 Gearbox Speed
19 Ignition 1 Ignition 83 nc
20 Aux 5 ISC Stepper 84 nc
21 Aux 6 ISC Stepper 85 DI 5 Ignition Switch (Controls
Main Relay Output)
22 Aux 7 ISC Stepper 86 nc
23 Aux 8 ISC Stepper 87 DI 6 AC Request
24 nc 88 nc
25 nc 89 nc
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26 nc 90 nc
27 Ground (Signal) 91 nc
28 Ground (Signal) 92 nc
29 nc 93 nc (+12V Hot
feed)
30 nc 94 nc
31 Ignition 5 Ignition 95 nc
32 Ignition 6 Ignition 96 nc
33 Ground 97 nc
34 nc 98 nc
35 Ground (Triggers) 99 +14V ECU Power
36 Trig 1 Trigger 1 100 +14V ECU Power
37 nc
38 nc Main Relay Injector 8 ECU Hold Power
Control
39 nc On Board | An Volt 1 via MAP
MAP jumper
40 +5V Out E-Throttle Aux 16 (Only needed if converting to
Relay E-Throttle)
41 Ground (Triggers) E-Throttle Ground
plug 1 (Signal)
42 Trig 2 Trigger 2 E-Throttle +5V Out
plug 2
43 nc E-Throttle An Volt 4
plug 3
44 | An Volt 1 via jumper Factory MAP E-Throttle An Volt 5
Sensor plug 4
45 An Volt 2 TPS E-Throttle An Volt 6
plug 5
46 Ground (Triggers) E-Throttle An Volt 7
plug 6
47 DI 2 Another CAM E-Throttle Aux 10
Sensor plug 7
48 nc E-Throttle Aux 9
plug 8
49 An Temp 2 IAT Expansion 1 Ground
(Signal)
50 An Volt 3 NB O2 Sensor [Expansion 2| +5V Out
51 VTA2 Buffered copy sent | Expansion 3| Injector 4
out pin 64
52 Ground Expansion 4| Injector 5
53 nc Expansion 5| Injector 6
54 An Temp 1 ECT Expansion 6 Aux 4
55 nc Expansion 7| An Temp 4
56 nc Expansion 8| An Temp 3
57 Aux 2 FP Speed (PWM) | Expansion 9 Ground
(Signal)
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58 Aux 3 CE Light Expansion +5V Out
10
59 Main Relay Output |Pull high to activate| Expansion DI 7
11
60 Trig 1 Trigger 1 Output | Expansion DI 8
12
61 Buffered Copy of An Expansion DI 9
Volt 2 13
62 Dl 4 Timing Retard Expansion An Volt 8
Request 14
63 nc Expansion An Volt 9
15
64 Buffered Copy of Expansion | An Volt 10
VTA2 (Pin 51) 16

Note: Injector Drive 8 has special hardware on it to control the Main Relay and so can't be used for Injection.

1.9 CAN Information
The following CAN (Controller Area Network) information is provided:

1.9.1 JZX90

CAN bus 1 and 2 each use a 4 pin connector with the same pinout as shown below.
CAN Connector
Pin Function Colour
1 GND Brown
2 CAN L Green
3 CAN H White
4 +14V Yellow

1.10 Known Issues

All plug-in ECUs are fully tested on a range of relevant wehicles, although there are often variations that have
not been tested. For this reason issues can arise.

WARNING: Always download the latest Installation Manual from linkecu.com and check the latest status of
known issues before installing the ECU.

Please contact your nearest Link dealer when suspecting a compatibility issue.

1.10.1 JZX90

The TRC light may come on, the factory TRC system is not supported by the Link ECU.

V1.4 and earlier will have two of the idle stepper motor wires the wrong way around, swap Aux 6 and Aux 7
pins around to make it work correctly.
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